
 

Introduction to Outlook 2007 

Information Technology Services 
Education and Development 

The University of Texas at Austin 

training@its.utexas.edu 

  



 

 

 

 

 

 

 

 

 

 

 

 

© 2008 Information Technology Services 

The University of Texas at Austin 

Revised September 15, 2008 

  



Table of Contents 

What is Microsoft Outlook? ...................................................................................................................... 1 

What is the MS Exchange Server? ............................................................................................................ 1 

Configuring Outlook ................................................................................................................................. 2 

Installation Considerations .................................................................................................................... 2 

Setting Up An Outlook 2007 Profile on Austin Exchange Servers ...................................................... 2 

Connecting to the Exchange server from Off-campus .......................................................................... 2 

Setting Up UT Austin LDAP Directory Information in Outlook.......................................................... 3 

The Microsoft Outlook “Interface” ........................................................................................................... 4 

Main Window and Reading Panes ........................................................................................................ 4 

Navigation Pane .................................................................................................................................... 4 

Message List ......................................................................................................................................... 5 

Reading Pane ........................................................................................................................................ 6 

To-Do Bar ............................................................................................................................................. 6 

Sending & Receiving Mail ........................................................................................................................ 7 

Reading Mail ......................................................................................................................................... 9 

Replying to and Forwarding Messages ................................................................................................. 9 

Mail Delivery Options (Signatures and Tracking) ................................................................................ 9 

E-mail Signatures .................................................................................................................................. 9 

Address Book .......................................................................................................................................... 10 

Adding Entries to your Contacts list ................................................................................................... 10 

Sending Mail Using Contacts List ...................................................................................................... 11 

Changing Search Order Of Your Address Book ................................................................................. 13 

Managing E-mail .................................................................................................................................... 13 

Sorting and Finding Messages ............................................................................................................ 13 

Deleting Messages  (And Then Permanently) .................................................................................... 14 

Archiving Messages ............................................................................................................................ 15 

Folders................................................................................................................................................. 17 

Message “Rules” ................................................................................................................................. 18 

Message Filters ................................................................................................................................... 20 

Calendars and Scheduling ....................................................................................................................... 21 

To schedule a new appointment: ......................................................................................................... 21 

Scheduling Meetings and Rooms ........................................................................................................ 23 

Assigning Permissions/Delegates ....................................................................................................... 25 

To view someone else’s calendar/folder: ............................................................................................ 27 

“To-Do” Tasks ........................................................................................................................................ 28 



Other Cool Features ................................................................................................................................ 30 

Notes & Journal Entries ...................................................................................................................... 30 

Public Folders ..................................................................................................................................... 30 

Conclusion .............................................................................................................................................. 30 

 



 

Getting Started with Outlook 2007  1 

What is Microsoft Outlook? 

 Microsoft Outlook 2007 is a groupware application that supports e-mail, calendars, 

contacts, “to-do” lists, and other features.  This is not to be confused because of its name, 

Outlook, with Microsoft Outlook Express. Microsoft Outlook is a substantially more powerful 

and feature-rich application.  It is a full groupware software system that works with Microsoft 

Exchange servers, bringing all of the rich features of Exchange servers to the fingertips of 

Outlook users, including automatic backups of messaging content as well as calendars, group 

resources, tasks, etc., all enabling individuals to work together as a group across the enterprise.   

 This handout covers the basic features of Outlook that you are likely to be using at UT 

Austin.  Comprehensive help on Outlook’s features are discussed in on-line tutorials well as web-

based training at office.microsoft.comProducts Outlook 2007 Help.  Additional training 

can be found at http://business.microsoftelearning.com/, accessible with a Microsoft Live ID 

available through UT Austin’s Microsoft e-learning license through the UT Austin Campus 

agreement.  Links to this information can be found under the “Tutorials” tab on the ITS Training 

website at www.utexas.edu/its/training.   

What is the MS Exchange Server? 

 Microsoft Exchange is integrated server software that manages electronic mail, shared 

documents and calendars and enables group collaboration through shared calendaring and 

resources.  Although Microsoft Outlook does not require a Microsoft Exchange server, Outlook 

offers more functionality when used in conjunction with this product.. The Exchange server that 

is owned by Information Technology Services is called the Austin Exchange Messaging Service 

or AEMS.  You might hear it called the “Austin Exchange Server” and generically, “Austin 

Messaging Services.” 

 You can activate an ITS Austin Exchange Mail Service account at 

http://www.utexas.edu/its/account.  There, you can decide if you will pay for your Exchange 

service using an “IT Pre-Paid Account”, or if your department will pay for it. If your 

departmental will be setting up ITS Exchange Services for you, they will assign you an e-mail 

address and set mailbox limits by going to the ITS TRAC pages 

https://utdirect.utexas.edu/its/account/department/.    

In either case, you can then view and/or configure your Exchange mailbox settings on the 

ITS TRAC webpages. 

 If your department or college runs an Exchange server that you wish to subscribe to, 

please contact the corresponding departmental Help Desk or Information Technology Support 

Group. 

 

 

http://business.microsoftelearning.com/
http://www.utexas.edu/its/training
http://www.utexas.edu/its/account
https://utdirect.utexas.edu/its/account/department/
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Configuring Outlook 

Installation Considerations 

 If you are installing Office 2007 on a Windows Vista system, most underlying operating 

systems services will already be installed to handle enhanced functionality in Outlook 2007, such 

as Instant Search.  If you have installed Office 2007 on Windows XP, you will need to update 

the Desktop Search program so the Instant Search feature of Outlook will work correctly.   In 

order to be able to read attachments sent by Outlook 2007, such as Word, Excel or Powerpoint 

2007 attachments, the Microsoft Compatibility Pack must be installed on the Office 2000, XP or 

2003 system.  In order to print to PDF or XPS, these options must be installed in Office 2007 by 

downloading them from Microsoft.  Other add-ins are available, including add-in template 

editors, which enhance Outlook functionality.  A map, add-in, for instance, enables a meeting 

planner to include detailed information about a meeting location, including a map on how to get 

there.  All of these options are available at the Microsoft website at www.microsoft.com and most 

are available for free.  

 Since Outlook 2007 and Office 2007 are updated frequently by Microsoft, it important to 

keep the package up-to-date, not only to deal with problem fixes or enhancements, but to help 

maintain security of the information created and managed on your system.  Typically, you or your 

system administrator should configure your computer system to automatically install updates to 

Office products in the same way that the operating system is updated.  Some caution and testing 

should be made on service packs, which tend to combine application fixes as well as product 

enhancements. 

Setting Up An Outlook 2007 Profile on Austin Exchange Servers 

 Please go to the ITS Windows Enterprise Services webpage for Outlook 2007 at  

http://www.utexas.edu/its/messaging/start.php  and follow the instructions for Outlook 2007.   

This is the most up-to-date information on setting up Outlook at UT Austin. 

Connecting to the Exchange server from Off-campus 

 There is more than one way to effectively communicate with the Austin Exchange server 

from off-campus.  Either your system must become part of the UT Austin network, or it must 

encrypt its communications with the Exchange server in a way that can be trusted.  The first way 

is to use the UT VPN product before connecting to the Exchange server with Outlook. Installing 

and using this product, available from www.utexas.edu/its/bevoware, generally will clear up any 

connection problems with the Exchange server from most Internet Service Providers (ISP) that 

you might be having.   Second, you can configure proxy server information to connect via HTTP 

rather than TCP/IP to the Exchange server, provided that your ISP does not restrict connections 

via secure HTTP connections.  Further information can be found in the Outlook 2007 instructions 

at http://www.utexas.edu/its/messaging/start.php.  A third, simpler way of connecting with 

restricted functionality is to connect via the web at http://www.austin.utexas.edu and logging in 

with your EID after clicking on the “Outlook Web Access” link. 

 

http://www.microsoft.com/
http://www.utexas.edu/its/messaging/start.php
http://www.utexas.edu/its/bevoware
http://www.utexas.edu/its/messaging/start.php
http://www.austin.utexas.edu/
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Figure 1: Outlook Web Access in Internet Explorer 7 

Setting Up UT Austin LDAP Directory Information in Outlook 

 To get to all e-mail addresses listed in the University White Pages directory, you will 

need to configure Outlook to be able to access the UT Austin LDAP directory.   Please go to the 

web instructions listed in the document for Outlook 2007, “Adding the UT Directory to Your 

Outlook Address Book.”  page at http://www.utexas.edu/its/messaging/answers/index.php and 

complete the procedure. The instructions for Outlook 2007 will be different than for Outlook 

2003, but the process is similar. 

  

http://www.utexas.edu/its/messaging/answers/index.php
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The Microsoft Outlook “Interface” 

 

 

Figure 2:  Microsoft Outlook 2007 interface 

Main Window and Reading Panes 

 In the Outlook Main Window’s Message List, the title of the folder you are currently 

viewing is displayed in its own title bar.  In the example below, the title of the open folder is 

Inbox.  The main window is divided with folder item headers in the left half and a preview of the 

selected item displayed in the right half.  You can choose where the reading pane will display by 

using the View menu. Under View choose Reading Pane then Right, Bottom, or Off. 

Navigation Pane 

 The Navigation Pane appears on the left side of your Outlook window and allows you to 

navigate to any folder or service within Outlook. Folders are expanded by clicking the plus sign 

to the left of the folder name and are collapsed by clicking the minus sign. To view the contents 

of a folder click once on the folder name itself. 

 

Message List 

Reading Pane 

Navigation 

Pane  

Folders 

To Do Bar 
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The icons at the bottom of the Navigation Pane help you 

navigate to the most commonly used Outlook services. You 

can view them as large icons with text labels, or as small 

graphic icons. To shrink the icons into small graphics simply 

drag the horizontal Separation Bar, located between the 

folder list and the Outlook icons, downward. 

Figure 3: Navigation Pane 

Message List 

 The Message List displays information from the e-mail message headers and can be sorted 

in many different ways. To sort by a field other than date, for instance, click the Arrange by drop 

down list and choose how you would like the messages to be sorted. You can also specify whether 

the messages should be sorted in ascending or descending order using the drop down menu to the 

right of the Arrange by menu, as well as display messages in groups. 

 

 

Figure 3A:  Sorting Messages 

 To delete a message using the Message List, click once on the message to select it then 

click the delete button from the toolbar.  You can also delete a message from the Message List 

by selecting the message and pressing the Delete key on your keyboard. Once you have deleted a 

message it will be moved to your Deleted Items folder on your e-mail server. To permanently 

delete a message you must also delete it from your Deleted Items folder.  You can undo a deleted 

message or other action, such as moving messages to a folder by selecting EditUndo. 

Separation Bar 
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Reading Pane 

 To view a message in the Reading Pane click once on the message in the Message List. 

To open a message in a new window, double-click on the message in the Message List. 

 

To-Do Bar 

 This new feature of Outlook 2007 allows you to see upcoming events and due tasks all on 

one display.  The To-Do Bar displays by default a “Date Navigator”, three upcoming appointments 

and items from the “Task List”  Just like the other parts of Outlook 2007, the specific items and 

number of items displayed can be changed. 

 

Figure 3A:  To Do Bar Calendar 
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Sending & Receiving Mail 

 To send a message in Microsoft Outlook 2007, choose New from the File menu and select 

Mail Message or choose Mail Message from the New drop down list in the toolbar.  You can also 

use keyboard shortcuts, such as Ctrl+N to start the new message dialogue. 

 

Figure 4:  Creating a New Mail Message 

In the New Message window, type the e-mail address of the recipient, a subject for your 

message, and the text of your message.  You can also format text, i.e., in HTML, but note that if the 

recipient is not using Outlook, your formatting may not display properly.  When you are ready to send 

the message, click the Send button on the toolbar. 

In Outlook 2007, the new message window is based generally on the same concepts as Word 

2007.  Details of this new user interface are in the Word 2007 document.  This section summarizes 

the most important commands.   

 

Figure 5: New Message Window 
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Quick Access Toolbar 

 Quickaccess Toolbar:  Located at the top of the Send Message Window, has the “Undo” 

button. 

 

 

Figure 5A:  Quick Access Toolbar 

Contextual Tabs 

Outlook 2007’s Send Message Window has four sets of functions that are divided into tabs with 

contextual commands. They are, with the most important commands: 

 

 

Figure 5B:  Send Message Tabs 

 

 Message: Set message font, past items, attach items, set message importance, check 

spelling  

 Insert:  Attachments, Compose and Insert Signatures, Insert drawings, Equations, etc. 

 Options: Compose as Text or HTML, set themes, enable BCC (Blind Carbon Copy), 

request delivery receipts 

 Format Text: Set font (again), search text, zoom in on text, etc. 

 

Most formatting text options are deactivated unless the option to compose the message as 

HTML is activated under the Options Tab. 

Microsoft Button 

Many valuable commands, such as file saving commands like “save as”, setting message 

permissions and Editor Options appear under the Microsoft Button. 

 

Figure 5C:  Microsoft Button 

Attaching Files 

 To attach a file to a message choose Insert and File or click the paper clip icon in the 

toolbar.  Then select the file you want to attach.  Outlook attaches the document to the message. If 

you receive a message with an attachment, an icon appears near the header information at the top of 

the email.  Double-click the attachment icon to view the attachment if you trust the source of the 

attachment; otherwise, right click the attachment to save it.   Please note that some attachments, 

such as zip files, exe files and database files might be filtered out by virus or spam filters installed 

on the intended recipient’s e-mail system.  The extension of a file can be renamed, so a zip file, for 

instance, becomes “z1p”, which requires replacing “1” with an “i” when saving the file. 
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Reading Mail 

 To check your messages, click the Inbox icon in the Navigation Pane.  Clicking once on 

the header in the header pane will display the message in the Reading Pane. Double-clicking the 

message header will open the message in a separate window. 

Replying to and Forwarding Messages 

 To reply to a message, select the message in the header pane and click the Reply button on 

the toolbar.  The Reply to All button sends your reply to everyone who received the original 

message.  Use this feature only if you want everyone to see your response.  Outlook also has a 

Forward button on the toolbar to forward a message to another e-mail address. 

Mail Delivery Options (Signatures and Tracking) 

Microsoft Outlook has several useful Mail Delivery Options that are not available with 

regular Internet mail.  For example, you can attach a signature to all messages by default, or you 

can request to receive notification when your recipient has read the message or schedule delivery of 

the message.  These options require the Microsoft Exchange server.  Click the Insert tab for 

signatures, and the Options tab to control message delivery timing.   

E-mail Signatures 

 E-mail signatures are easy to configure in Outlook.  From the options menu, select Signatures. 

 

Figure 6: Email Signatures from the “Insert Tab: 

 The E-mail signature dialogue in Outlook 2007, selected by clicking on the Insert Tab  

Signature Signatures, allows you to enter in the actual signature, and specify which signature 

applies to new messages as well as replies to messages.  
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Figure 7: Signatures in Outlook 2007  

 While you may implement any number of mail signatures, only the signature configured in 

this dialogue to be automatically included with messages will be conveniently accessible.   

 Keep in mind that the formatting of your signature must be compatible with the formatting 

of your message. If your use HTML in your e-mail signature and use plain text by default when in 

your composing messages, formatting or other information might be lost. 

 

Address Book 

 Outlook has multiple Address books. The Contacts list stores your own list of addresses 

and distribution lists that will be maintained on the server.  The Global Address list contains all 

users and distribution lists on your Exchange server.  The LDAP directory, directory.utexas.edu, 

provides access to all members of the UT Austin community who choose to share their e-mail 

addresses. 

Adding Entries to your Contacts list 

 To add or edit entries in your Exchange server-stored Contacts list, click on the Contacts icon 

in the Navigation Pane.  
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Figure 8:  Contacts Icon 

 

In the Contacts window, click the New icon on the toolbar to enter a new contact.  You will 

get a Ribbon-based entry screen similar to those seen with other Office 2007 products. You can 

enter extensive information on a contact, including the contact’s photo and digitally scanned 

business card.  Note also the integration with OneNote in the “Contact Notes”.  When finished, 

click on Contact Tab Save & Close.  

 

 

Figure 9:  Contact Entry Window 

 

Sending Mail Using Contacts List 

 When you want to send mail to a user in your Contacts List, click the To: button while 

composing the mail to display your contacts. If you do not see your contacts listed, choose 

Contacts from the pull down menu. In contrast, to send e-mail to someone from the Exchange 
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Server Global Address List, click the To: button and select Global Address List from the drop 

down menu. 

 

Figure 10:  Selecting Global Address List as Source of Email Addresses 

 

 You can add multiple recipients by clicking once on the recipient name in the list, then 

clicking on the To, CC, or BCC buttons. 
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Changing Search Order Of Your Address Book 

 In Outlook, under Tools TabAddress BookToolsOptions, you have the ability to 

determine which address list comes first.  Knowing which list comes first is important if you 

communicate with people who are not Exchange subscribers.  There are many duplicate names at 

UT Austin and it is always good to know from which list your e-mail addresses come from. 

 

Figure 11: Changing Address Book Search Order 

Managing E-mail 

 As you receive more messages, you will want to manage your e-mail more efficiently.  

Microsoft Outlook has many ways to help you organize your mail. 

Sorting and Finding Messages 

 When you have hundreds of messages in your Inbox, it’s not always easy to locate the 

message you want.  Outlook has Sort and Find features to help. 

 To change how the messages are sorted Right Click the Arranged by bar just below the 

title bar that displays the current folder name in the header pane. 

 
Figure 12: Sorting Messages by Date 
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 You can also group messages by the selected category or categories, if you check the Show 

in Groups checkbox, your messages will be separated by group labels. 

 

Figure 13:  Sorting Messages by Group 

 

 If sorting doesn’t help, you can search for text in a message.  Simply type in text in the 

search box above the Message List and you should get an instantaneous result.  Enter the text you 

want to find in the dialog box and select the folders to be searched.  Outlook will search for your 

text and display a list of messages that meet the criteria in the header pane. 

 

 

Figure 14: Finding Messages Using the Search Box and Options 

 One item that might be of assistance for individuals installing Office 2007 on Windows XP 

is that there is the Instant Search program that comes with Office 2007.  An enhancement to 

existing functionality of the operating system, it provide instantaneous search of e-mails as well as 

system content, enabling you to find messages and other valuable content much faster.  This option 

works in conjunction with Desktop Search from Microsoft and needs to be downloaded from 

Microsoft’s website, www.microsoft.com by using the search terms “Instant Search”. 

 

Deleting Messages  (And Then Permanently) 

 

 To delete a message, select the message in the header pane and press the Delete key on 

your keyboard or click on the delete tool , on the toolbar.  Outlook transfers the message to 

the Deleted Items folder.  To retrieve a message from Deleted Items, open that folder, select the 

message and choose Edit, Move To Folder and select the folder to move it to.  To permanently 

delete a message, select the message and press Shift + Delete on your keyboard. 

http://www.microsoft.com/
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 You can also right-click on messages in the message list to display a list of commands like 

Print, Delete, Reply, Move To Folder, and others or “drag and drop” the message from its current 

location to the desired destination folder. 

 To permanently remove the contents of the Deleted Items folders on a regular basis, do the 

following: 

 

1. Right Click on Deleted Items and select Properties. 

2. Select the AutoArchive tab and select Archive This Folder Using These Settings.  Then 

select Permanently delete old items. 

3. Then, set the interval at which items are deleted by setting the value at Clean out items 

older than... The default is 2 months. 

 

 

Figure 15:  Using Autoarchive to Automatically Remove Deleted Messages 

Archiving Messages 

 The process of archiving messages can be accomplished in two ways, through manual 

archiving or through auto archiving. 

 To archive messages manually, select FileArchive. You can select archiving all 

messages under all folders according to the AutoArchive Settings, or archive specific folders.  

These messages are normally selected by date.  Further control requires using AutoArchive 

settings. 
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Figure 16: Archiving Messages 

 The folder in which messages will be archived is set up in FileData File Management. 

You can change this value to be anything you want it to be.  Files created through Outlook 

archiving tend to be large, so take care that message archives do not exceed the size of common 

backup media, such as Flash drives, CD Roms, Portable Hard drives or DVDs   

 To set up automatic Archiving, AutoArchive settings have to be activated for all Outlook 

folders on the Exchange server or specific folders.   Access these settings by left-clicking on the 

desired folder, right click Properties, and select the AutoArchive Settings Tab: 
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Figure 17:  AutoArchive Settings Tab 

 

 The AutoArchive tab enables you to remove messages that are older than a specific time 

interval—days, months, etc.—and then to determine how to dispose of them.  A managed system 

on Active Directory can have message retention group policies set, or you can set default auto-

archive settings for all messages. Take care about the size of the archive folder.  If it is too large, it 

will be difficult to backup or save onto a single CDRom or DVD.  Often, it is better to manually 

archive messages over a specific time period, such as a fiscal year, rather than doing so 

automatically.   

Further tutorials on archiving messages are available at the Microsoft Office help site at 

office.microsoft.comProductsOutlook Outlook 2007 Help. 

Folders 

 Use folders to help organize the messages you receive.  For example, you can transfer all 

correspondence with your parents into a folder called Personal.   

1. To create a new folder in your Inbox, choose File New and then select New Folder. 

2. Type a name for the folder in the dialog box, and select the type of information the folder 

will contain.  Finally, select the destination for the folder in the dialog box and click OK. 

(To create the folder in your Inbox, click on the Inbox.) 
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Figure 18: Creating a New Folder For Saving Messages 

3. To move a message to another folder, you can drag and drop it to another folder in the 

Navigation Pane.  You can also select the message and choose Edit and Move to Folder 

or Copy to Folder if you want to copy the message to another folder and not just move it.  

4. You can also set up a Message Rule to automatically move messages to your new mail 

folder. 

Message “Rules” 

In Outlook you can create “rules” that filter your mail.  For example, you might want to 

automatically transfer all messages from a finance professor friend in College Station, Joe User, to 

a folder called Finance.  For messages that do not need to be retained, such as absence information 

easily obtained elsewhere when required, daily Messages Rules allows you to automatically delete 

them. 

 

1. To create a mail rule, choose Tools and then select Rules and Alerts. 

2. Click the New Rule button. 

3. Select the type of rule you want to create.  Then click the underlined words in the Rules 

Description section of the dialog box and fill in the required information. For example, the 

rule in the example below moves all messages from Joe User to the folder called Finance. 

(finan in the illustration) 
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Figure 19: Message Rules for Automatically Handling Messages 

 

4. To run the rule anytime you want, including when the rule’s behavior or criteria are 

modified, select the rule you want to run and select Run Rules Now.  You can run rules on 

all folders, or you can select a specific folder run the rules again. 

 

Figure 20:  Typical Email Rule Names and Details of Sample Rule 
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Message Filters 

 The two main mechanisms that can be used to filter out messages, aside from message 

rules, include Junk Mail Filters, and View Filters.   Junk mail filters automatically take messages 

that meet minimum criteria for junk or have been flagged as junk to the respective junk mail 

folder.   It is prudent to check this folder sometimes due to false positives, but generally, in 

conjunction with a good spam filtering policy through the email provider, spam filters are effective.   

Junk mail filters are occasionally updated by Microsoft, so it is prudent for you or your system 

administrator to update it occasionally by making sure that Microsoft Updates are enabled. 

 To screen out or filter messages that might be of value due to content, coming from a 

specific person, etc., Outlook 2007 continues the Outlook 2003 style view filters. 

 These are activated by going to ViewCurrent ViewCustomize Current View and 

then clicking on Filter.  This will bring up a pop-up that will allow you to filter messages. 

 

Figure 20A: Message Filters Selected to Show Only Unread Messages 

 Message filters provide four options for selecting messages: 

 Messages:  Select messages on the basis of From, a keyword or other fields 

 More Choices: Select messages on the basis of priority, category, size, etc. 

 Advanced:  Select messages on the basis of field values 

 SQL:  Use the SQL language to select messages 

 Message filters are powerful functions that enable you to manager your email efficiently. 

When combined with good Mail Rules, good folder management, message searching and message 

sorting, efficient message retrieval and use improves the usefulness of Outlook 2007 in your daily 

work.  It is important to undo message filters once you have finished working with them.  A 

complex filter might be difficult to undo if a user reports mail problems when in reality, the 

messages were filtered using view filtering. 



 

Getting Started with Outlook 2007  21 

Calendars and Scheduling 

 Microsoft Outlook 2007 is a sophisticated personal and group scheduling program.  Click 

the Calendar button in the Navigation Pane to use the scheduling feature of Outlook.  Outlook's 

Calendar appears in the figure below.  Generally visible from the calendar view, as illustrated 

below, are upcoming appointments, a display of the current month calendar with days with 

appointments marked in bold, a display of other people’s/resource calendars that have been selected 

for view and tasks that are due for the current day. 

 Several different views are available, including the daily, weekly, monthly, work week, etc. 

 

 

Figure 21: Outlook Calendar on Exchange, Weekly View 

To schedule a new appointment: 

1. Choose File New and select Appointment or click the New button in the toolbar and 

choose Appointment.   

2. Enter information about the time, date, and location of the appointment.   

3. If your meeting is recurring, click the Recurrence button to specify the details of how 

often and when the meetings Recurs. 
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Figure 22:  Meeting Recurrence 

4. Click Save and Close to schedule the meeting.  It will now appear on your Outlook 

calendar. 
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Scheduling Meetings and Rooms 

 Outlook can also be used to schedule meetings with other users on your Exchange Server.  

Note that the user interface is similar in features to that of composing messages, with several tabs, 

including the Meeting, Insert and Format Text tabs. 

To schedule a meeting with multiple people: 

 

 

Figure 23: Example of A Meeting With Multiple Attendees 

 

1. Select FileNewNew Meeting Request and choose Meeting Request or select 

Meeting Request from the New button drop down list.  You will see the Meeting Request 

screen which will be defaulted to the Appointment display. 

2. Click the To: button to select the people you need to attend the meeting.  

3. Specify a Subject, Location, Date and Time.  If your meeting attendees also use your 

Exchange server, you can check their availability by clicking the Scheduling button to 

move the display from the Appointment button.  It will display the free and busy times of 

the other meeting attendees.  You can even have Outlook select the first date and time that 

all parties are available by choosing AutoPick.  If you select a Resource, its schedule can 

also be taken into consideration when setting up a meeting with a group of people.   

4. To automatically add a resource to your meeting, you will need the Create items privilege 

for that resource, which the owner can grant as a permission or delegate.  Otherwise, the 

resource owner, in addition to meeting participants, must accept the proposed meeting. 
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Figure 24:  Adding A Resource To A Meeting 

5. The meeting appointment is sent like an e-mail message.  Attendees will be prompted to 

accept or decline and send automatic notification back to you. When they accept, the 

meeting will automatically be added to their own Outlook calendar.  After creating the 

meeting, to mark it as Private, right click on the meeting and select Private off of the drop-

down menu. 
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Once a meeting is schedule, you can look at your calendar with the daily, weekly or 

monthly view and see visually where it relates to other meetings and events. 

 

 

Figure 25:  Sample Calendar Entry For A Single Day 

Assigning Permissions/Delegates 

 You may want to allow other Exchange users to have access to some of your services in 

AEMS. Assigning delegates grants other users permission to do things like view your calendar, 

send e-mail messages on your behalf, and tasks to your to-do list, and more. 

 

To add a delegate: 

1. From the Tools menu choose Options, then click the Delegates tab. 

2. Click the Add button and select the delegate from the Global Address List. 

3. Click the Add button in the dialog box to add that person as a delegate. 

4. Assign the appropriate permissions for each service and click OK. 
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Figure 26:  Sharing A Calendar 

 

To share your calendar folder: 

1. Click on the Calendar icon to switch to the Calendar view. 

2. Right click on your calendar from the Navigation Pane and select Properties from the 

drop-down menu 

3. Click on the Permissions tab 

4. Click on the Add button to locate the user from the Global Address list you want to add. 

5. Click on the specific individual to update their permissions.  You can also set default 

permissions for all users of the Exchange server. 

 



 

Getting Started with Outlook 2007  27 

 

Figure 27:  Calendar Permissions 

To view someone else’s calendar/folder: 

 If another Exchange user has made you a delegate, or has shared one of his Exchange 

folders, such as his calendar, you can view it and may be allowed certain editing privileges. 

1. From the File menu select Open > Other User’s Folder. 

 

Figure 28: Looking At Someone Else’s Calendar 

2. Click the Name button to locate the user from the Global Address List and click OK. 

3. Select which folder you would like to view from the Folder type: field and click OK. 

One additional feature in Outlook 2007 is the ability to compare other people’s calendars 

with yours side-by-side.  Multiple calendars are usually displayed side-by-side with each other.  
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If you click on the “Left Arrow” next to the calendar heading, i.e., “Fac 227” or “Com 8”, the 

calendars will be merged together and can be compared side-by-side. 

 

 

Figure 28A:  Calendars Displayed Side-By-Side 

 

 

Figure 28B:  Merged Calendars 

 This features enables you to compare the activities of multiple people or resources in a 

single page, or for instance, to coordinate multiple parallel tracks for an event.    

“To-Do” Tasks 

 Outlook 2007 allows you to create, track and assign tasks to others.  Changes implanted 

into Outlook 2007 allows you to better integrate tasks with e-mail, allowing you to mark an e-mail 

item as a task by right-clicking the message and marking the item for Follow-Up. You can also 

create new tasks in Outlook while by choosing Task from the New button in the toolbar or by 

entering the task directly into the Task window.  To view the Task window, click the Tasks button 

in the Navigation pane.  

 

Figure 29:  To Do/Task List In Outlook 
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 To enter a new task from the New  Task button, enter the information for the subject, 

dates, status, and details. To assign the task to someone on the Exchange server, click the Assign 

Task button in the toolbar then click the To: button to find the recipient. The recipient will receive 

the task in his/her Inbox with all of the information you entered included. 

 

 

Figure 30: Entering In A Task 

 To enter a task from the Task window, simply click in the next empty row above the list of 

tasks and begin typing. When you press Enter, the task is added to your To-Do list.  Tasks are kept 

in the Tasks folder and are also displayed in your “To Do Bar” for the next few days ahead.   

 Tasks can also be made recurring, which will then enable Outlook to pop up a reminder on 

a regular basis, such as when a weekly report is due.  A recurring task can be assigned to other 

people too.  In the Task window, click on Recurrence, and fill in the appropriate checkbox, 

including the End Date of the Task Recurrence.  
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Figure 31:  Task Recurrence 

Other Cool Features 

Notes & Journal Entries 

 

 Like appointments and tasks, you can create “sticky” notes and/or journal entries which can 

be saved for yourself and/or sent to others on the Exchange Server.   

Public Folders 

 

 Public folders which can be viewed and shared by others on the Exchange Server can be 

created by the server administrator.  To view a Public Folder click the folder list icon in the 

Navigation pane. Near the bottom of the list you will see Public Folders with a plus sign next to it. 

Click the plus sign to expand the necessary folders until you find the folder you are looking for. 

 

Conclusion 

 Outlook is a flexible and dependable communications program that utilizes the services 

provided by Microsoft Exchange services to facility individual and group productivity. 

 


